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Kit Contents

Investigator
Catalog number
No. of 20 µL reactions

387516
576

Quantiplex Pro FLX Plate 6

Male Control DNA M1 (50 ng/µL) 0.2 mL

QuantiTect® Nucleic Acid Dilution Buffer 1 vial

Quick-Start Protocol 1
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Shipping and Storage

The Investigator Quantiplex Pro FLX Kit is shipped at 2–8°C. The Quantiplex Pro FLX plates

can be stored at room temperature (15–25°C), protected from light in the aluminum bags.

Partially used plates can be put back into their aluminum bag, including the desiccant, and

stored for up to 4 weeks until being used up completely. The QuantiTect Nucleic Acid Dilution

Buffer and the Control DNA M1 should be stored at 2–8°C. Under these conditions, the

components are stable until the expiration date indicated on the kit.

Intended Use

The Investigator Quantiplex Pro FLX Kit is is intended for molecular biology applications in

forensic, human identity, and paternity testing. This product is not intended for the diagnosis,

prevention, or treatment of a disease.

All due care and attention should be exercised in the handling of the products. We

recommend all users of QIAGEN® products to adhere to the NIH guidelines that have been

developed for recombinant DNA experiments, or to other applicable guidelines.
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Safety Information

When working with chemicals, always wear a suitable lab coat, disposable gloves, and

protective goggles. For more information, please consult the appropriate safety data sheets

(SDSs). These are available online in convenient and compact PDF format at

www.qiagen.com/safety where you can find, view, and print the SDS for each QIAGEN kit

and kit component.

Quality Control

In accordance with QIAGEN’s ISO- certified Quality Management System, each lot of

Investigator Quantiplex Pro FLX Kits is tested against predetermined specifications to ensure

consistent product quality. The Investigator Quantiplex Pro FLX Kit meets ISO 18385

requirements.

https://www.qiagen.com/safety
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Introduction

Human identification is commonly based on the analysis of short tandem repeats (STRs), or

single nucleotide polymorphisms (SNPs), depending on the demands of an examination or on

the sample quality. These multiplex assays used for human identification are complex systems

that require a defined range of template input.

The Investigator Quantiplex Pro FLX Kit provides quantification of human genomic DNA, male

DNA, and the integrity of DNA in a sample using quantitative real- time PCR. The kit is

designed to confirm whether a sample contains sufficient DNA to enable DNA fingerprinting

analysis (such as STR or SNP analysis). Furthermore, the kit may help in establishing if a

sample contains inhibitors that may interfere with such applications, thus necessitating further

sample purification. In addition, the DNA degradation system allows for a more precise

assessment of the degradation status of the DNA.

The Investigator Quantiplex Pro FLX Kit uses a hot- start DNA polymerase enzyme and

QuantiNova Guard additive. These unique components further improve the stringency of the

antibody-mediated hot-start.

The kit also features a built-in control for visual identification of correct pipetting and Q-Bond®,

an additive in the buffer that enables short cycling steps without loss of PCR sensitivity and

efficiency.

The assay comes in a lyophilized 96-well plate format, which provides a high sample input

flexibility of 1–18 µL, and up to approximately 10x higher sensitivity when using the maximum

input. Breakable plates allow to adapt to individual throughput needs. Setup of reactions is

fast and simple, and plates can be stored at room temperature before use.
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Figure 1. Features of the Investigator Quantiplex Pro FLX plate.

Principle and procedure

The Investigator Quantiplex Pro FLX Kit is a ready-to-use system for the detection of human and

male DNA and parallel assessment of DNA degradation using quantitative real-time PCR. The

kit provides fast and accurate quantification of human DNA in forensic database and

casework samples.

Detection of amplification is performed using TaqMan® probes and a fast PCR chemistry. The

dual-labeled probes contain a fluorescent reporter and a quencher at their 5' and 3' ends,

respectively. During the extension phase of PCR, the 5' and 3' exonuclease activity of the

DNA polymerase cleaves the fluorophore from the quencher. This results in detectable

fluorescence that is proportional to the amount of accumulated PCR product.
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Target regions

The target region for human DNA quantification (4NS1C®) is a 91 bp proprietary region

present on several autosomes of the human genome. It was selected to give high sensitivity

and is detected using the FAM™ dye channel on Applied Biosystems instruments.

Furthermore, the kit detects a longer autosomal amplification product (353 bp) targeting the

same locus as the 91 bp 4NS1C autosomal target. Due to the differently sized autosomal

targets, the longer autosomal target is more susceptible to DNA degradation, allowing for a

precise assessment of the degradation status of the DNA. The larger 353 bp autosomal

quantification target region is detected using the ATTO 550 dye channel on Applied

Biosystems instruments.

The target region for male DNA quantification was selected in order to give high sensitivity in

the presence of mixed female/male DNA samples. It is detected as an 81 bp fragment using

the ATTO 647N dye channel on Applied Biosystems instruments.

Internal Control

The Investigator also contains a balanced internal amplification control that is used to test

successful amplification and identify the presence of PCR inhibitors. This heterologous

amplification system is detected as a 434 bp internal control (IC) in the JOE™ dye channel on

Applied Biosystems instruments. The IC is designed to be more sensitive to inhibitors than the

human and the male quantification targets. The comparison of the CT values of the IC system

for DNA standards with the CT values of the IC system for unknown samples may provide an

indication of potential inhibition of the reaction in the unknown samples. Therefore, even if the

IC system reports the presence of inhibitors in the sample, the DNA quantification will typically

provide a reliable result. The presence of inhibitors in the sample may affect the downstream

application and must be considered.
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Laboratory validation with relevant inhibitors should be performed to determine criteria for

detecting inhibition.

Target
Amplicon length
(bp) Channel Ploidy Copy number

Human target, small autosomal (Human) 91 FAM Diploid Multi-copy

Human target, large autosomal
(Degradation)

353 ATTO
550/TAMRA

Diploid Multi-copy

Human male target (Male) 81 ATTO 647N/CY5 Haploid Multi-copy

Internal PCR control 434 JOE n/a Synthetic
fragment

Table 1. Targets, amplicon lengths, and channels for Investigator Quantiplex Pro FLX Kit

Quantiplex Pro FLX Reaction Mix

The Quantiplex Pro FLX Reaction Mix contains a hot start DNA polymerase and Quantiplex

Pro reaction buffer. The DNA polymerase is provided in an inactive state and has no

enzymatic activity at ambient temperatures. The antibody-mediated hot- start mechanism

prevents the formation and extension of nonspecific PCR products and primer–dimers during

reaction setup and the first denaturation step. Therefore, this mechanism allows higher PCR

specificity and accurate quantification. At low temperatures, the DNA polymerase is kept in

an inactive state by the antibody and QuantiNova Guard, which stabilize the complex and

improve the stringency of the hot start. After raising the temperature for 3 minutes to 98°C, the

antibody and QuantiNova Guard are denatured and the DNA polymerase is activated,

enabling PCR amplification. The hot start enables rapid and convenient room-temperature

setup.

Furthermore, the Quantiplex Reaction FLX Mix contains the additive Q-Bond, which allows

short cycling times on standard cyclers and on fast cyclers with rapid ramping rates. Q-Bond

increases the affinity of the DNA polymerase for short, single-stranded DNA, reducing the time
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required for primer–probe annealing to a few seconds. In addition, the unique composition of

the buffer supports the melting behavior of DNA, enabling short denaturation and

annealing/extension times that result in an overall PCR run time of approximately 60 minutes.

The Quantiplex Pro FLX Reaction Mix is also based on the unique QIAGEN PCR buffer system.

The buffer contains a balanced combination of KCl and NH4Cl, which promotes a high ratio

of specific to nonspecific primer binding during the annealing step of each PCR cycle. This

creates stringent primer annealing conditions, leading to increased PCR specificity.

Male Control DNA M1 and standard curve

DNA quantification standards are critical for accurate analysis. We strongly recommend a

27-fold dilution series with 4 concentration points in the standard curve for each assay. The

Control DNA contains pooled male DNA at a concentration of 50 ng/µL. To ensure pipetting

accuracy, the minimum input volume of DNA for dilutions should be 5 µL. The standard curve

is designed to be easily set up using a convenient 1:27 dilution series. If using QuantiTect

Nucleic Acid Dilution Buffer to dilute the Control DNA, the dilutions are stable for at least

1 week at 2–8°C.

Important: Male Control DNA M1 is optimized for use with the Investigator Quantiplex kits

only.

Templates for routine work

In order to streamline the instrument setup and the analysis of the results on the QuantStudio 5

Real- Time PCR System, Applied Biosystems 7500 Real- Time PCR System for Human

Identification, and the Applied Biosystems 7500 and 7500 Fast Real- Time PCR Systems,

QIAGEN has developed a set of template files. Download the template files from the

Resources tab of the product page.
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Description of protocols

Protocols for the following cyclers are provided in this handbook.

l QuantStudio 5 Real-Time PCR System

l Applied Biosystems 7500 Real-Time PCR System for Human Identification

l Applied Biosystems 7500 Real-Time PCR System
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Equipment and Reagents to Be Supplied by User

When working with chemicals, always wear a suitable lab coat, disposable gloves, and

protective goggles. For more information, consult the appropriate safety data sheets (SDSs)

available from the product supplier.

Equipment

l Microplate Vortex Mixer

l Real-time thermal cycler

o QuantStudio 5 Real-Time PCR System

o Applied Bioystems 7500 Real-Time PCR System for Human Identification

o Applied Biosystems 7500 Real-Time PCR System

Material

l Pipettes and pipette tips

l qPCR adhesive plate foil, perforated (100) (cat. no. 386055)

l qPCR adhesive plate foil (100) (cat. no. 209003)

l Optical film compression pad (e.g., VWR cat. no. 76637-856)

Reagents

l Nuclease-free (RNase/DNase-free) consumables: special care should be taken to avoid

nuclease contamination of all reagents and consumables used to set up PCR for sensitive

detection of human DNA

l Nuclease and DNA-free water (e.g., PCR Water (10 x 1 mL), cat. no. 17000-10)
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Investigator Quantiplex Pro Calibration Kit (cat. no. 387416)

l Calibration Standard FAM, Calibration Standard JOE, Calibration Standard ATTO 550,

Calibration Standard ROX, Calibration Standard ATTO 647N, Quantiplex Pro Calibration

Buffer
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Important Notes

Selecting kits and protocols

This handbook contains protocols and recommendations for DNA quantification using the

instruments listed in Table 2. Real-time cyclers other than these have not been validated by

QIAGEN for DNA quantification using the Investigator Quantiplex Pro FLX Kit.

Real-time thermal cycler Cycler calibration Quantification

QuantStudio 5 Real-Time PCR System on page 24 on page 30

Applied Biosystems 7500 Real-Time PCR System for Human Identification on page 50 on page 80

Applied Biosystems 7500 Real-Time PCR System on page 66 on page 80

Table 2. Protocols for the Investigator Quantiplex Pro FLX Kit with different real-time thermal cycler

Contamination risks

All reaction mixtures should be set up in an area separate from that used for DNA isolation

and PCR product analysis (post- PCR) in order to minimize the potential for cross-

contamination. In addition, use disposable tips containing hydrophobic filters to minimize

cross-contamination.

Do not remove the seal on the reaction plates once the amplification is complete. Removing

the plate seal increases the risk of contaminating subsequent reactions with amplified product.
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Controls

No-template control (NTC)

Replicates of NTC reactions should be included in each quantification run in order to detect

contamination. NTCs should contain all the components of the reaction, except for the

template. Quantification using the Investigator Quantiplex Pro FLX Kit is highly sensitive;

despite the fact that the reagents contained in the Quantiplex Pro FLX Kit undergo strict quality

controls to assess that they are free of human DNA contamination, background DNA may be

detected in rare cases due to the high assay sensitivity. Take great care to avoid

contamination when pipetting the NTC.

We recommend performing NTC reactions at least in duplicate.

Internal positive control

An internal, positive control (detected using a TaqMan probe) is used to test for successful

amplification and for the presence of PCR inhibitors. Primers, TaqMan probe, and template for

the internal control are all contained in the Quantiplex Pro FLX plate.

Calibration of PCR Systems

When using the QuantStudio 5 Real-Time PCR System, or the Applied Biosystems 7500 Real-

Time PCR System with Investigator Quantiplex Pro FLX, custom dye calibration for FAM, JOE,

ATTO 550, ROX, and ATTO 647N is needed. To achieve optimal performance, calibrate with

the Investigator Quantiplex Pro Calibration Kit (cat. no. 387416). However, standard system

dye calibrations for FAM, JOE, TAMRA, ROX, and Cy®5 might be used. In this situation, use

TAMRA for the Degradation target and Cy5 for the Male target. Refer to the instrument user

manual for additional information on correct setup.
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General guidelines for automation

Stick to the logic of the manual procedure described in this handbook:

l Open the seals of the plate just before starting a run.

l Do not operate the system in very humid areas (>60%), as lyophilized cakes rehydrate and

resolution is problematic.

l Always apply the higher volume first to dissolve the cake.

l Do not move pipette tips into the cake during setup. Adjust z-heights to be above the cake

for the first liquid addition. This height must accommodate for loosened cakes that may be

upside down in the plate.

l Always vortex the finished plate after sealing. Do not fully rely on automated mixing during

setup, as there might be spots of lyophilized material at the side of the walls.
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Protocol: Setting Up Investigator Quantiplex Pro
FLX Plates

This protocol describes the preparation of reactions in the Investigator Quantiplex Pro FLX

plate.

Important points before starting

l Do not open plates in advance. Remove seals just before starting setup.

l Before removing the seals from the plate, make sure lyophilized cakes do not stick to the

seals. Tap the plates on the bench to bring all cakes down.

l Loosened cakes, spots on the tube wall, or cakes with slightly varying appearance do not

have impact on the performance of the assay.

l Avoid high humidity in the laboratory. We do not recommend opening plates in an

environment with over 60% humidity.

l We strongly recommend to always start with the addition of the higher volume during

setup. If using >9 µL sample input, add sample first to dissolve the lyophilized cake, and

then fill up to the final volume with water. Pipette above the cake surface.

l Set up all reaction mixtures in an area separate from that used for DNA isolation and PCR

product analysis (post-PCR).

l Use disposable tips containing hydrophobic filters to minimize cross-contamination.

l Dilutions of DNA quantification standards in QuantiTect Nucleic Acid Dilution Buffer can

be stored between 2–8°C for at least 1 week.

l Reaction setup can be done at room temperature (15–25°C).
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Procedure: Preparing the optical plate for reaction setup

1. Prepare fresh serial dilutions of the Male Control DNA M1. Vortex for at least 5 s, and

centrifuge each dilution briefly before removing an aliquot for the next dilution. Use a new

pipette tip for each dilution. Make sure not to introduce cross-contamination.

Serial dilution of Control DNA M1 (ng/µL) Control DNA (µL) QuantiTect Nucleic Acid Dilution Buffer (µL)

50 Undiluted DNA –

1.8519 5 130

0.0686 5 130

0.0025 5 130

Table 3. Serial dilution of Control DNA M1

Note: Alternative standard curves are listed in “Appendix: Alternative Standard Curves”.

2. Thaw samples for quantification if they were stored frozen.

3. When not using the entire plate, break the desired number of 8-tube strips from the plate

(Figure 2 on page 22).

Note: The unused part of the sealed PCR plate should be stored in the aluminum bag with

desiccant and used up within 4 weeks.

4. Peel the perforated seals from the plate, or groups of 8-tube strips (Figure 3 on page 23).

When using the entire plate, seals can be removed with the help of 1/3 of an adhesive

foil (Figure 4 on page 23). Start setting up reactions immediately.

5. If using less than 9 µL sample input, start the setup with adding the volume of water

required to give a final volume of 18 µL added to the cake.

6. Add 18 µL water or Nucleic Acid Dilution Buffer to the NTC (No Template Control) wells.

Z_Investigator/Quantiplex/ProFLX/02 Protocols/18_AppxAlternStdrdCurves.htm
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7. Add 16 µL water or Nucleic Acid Dilution Buffer and 2 µL control DNA M1 dilutions to the

individual wells of the standard row. It is required to run duplicates of the control DNA

dilutions for each assay and on each reaction plate.

Well contents

1 2 3 4 5 6 7 8 9 10 11

A 50 NTC UNK UNK UNK UNK UNK UNK UNK UNK UNK

B 50 NTC UNK UNK UNK UNK UNK UNK UNK UNK UNK

C 1.8519 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

D 1.8519 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

E 0.0686 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

F 0.0686 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

G 0.0025 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

H 0.0025 UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK

All content in ng/mL. NTC, no-template control; UNK, unknown sample.

Table 4. Example plate setup of reactions

8. Add samples to reaction wells (variable input volumes from 1–18 µL).

Component 1 reaction

Quantiplex Pro FLX Reaction Mix and Primer Mix Lyophilized cake

Sample Variable (1–18 µL)

Water Fill up to 18 µL

Total reaction volume 20 µL*

* Lyophilized cake + 18 µL input volume will yield a final PCR reaction volume of 20 µL.

Table 5. Reaction setup
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Note: If your sample input volume is not 2 µL, a correction factor needs to be applied to

your sample concentration. You can also use the QIAGEN Quantification Assay Data

Handling Tool for automated concentration correction calculation.

Sample input volume (µL) Concentration correction factor (calculated concentration divided by ...)

1 0.5

2 –

3 1.5

4 2

5 2.5

6 3

7 3.5

8 4

9 4.5

10 5

11 5.5

12 6

13 6.5

14 7

15 7.5

16 8

17 8.5

18 9

Table 6. Correction factors for calculations of sample concentrations
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The concentration correction factor can be obtained by dividing the sample input volume

by 2.

9. Add water where still needed to all samples or controls to result in a total liquid volume of

18 µL. Never run reactions with less than 18 µL.

10. Seal the plate or the 8-tube strips with the qPCR adhesive plate foil and vortex for 5 s.

11. Centrifuge briefly.

12. Continue with the amplification and analysis as described for the corresponding thermal

cycler.

Note: Always use a compression pad if using the entire plate.

Note: If using 8-tube strips, please follow the PCR cycler manufacturer’s recommendation

for the use of strips and their correct position within the cycler block.

Figure 2. Breaking of Investigator Quantiplex Pro FLX Plates.
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Figure 3. Peeling of Investigator Quantiplex Pro FLX 8-tube strips.

Figure 4. Peeling of the entire Investigator Quantiplex Pro FLX Plate.
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Protocol: Cycler Calibration Using the
Investigator Quantiplex Pro Calibration Kit and
QuantStudio 5 Real-Time PCR System

This protocol is optimized for use of the Investigator Quantiplex Pro Calibration Kit on the

QuantStudio 5 Real- Time PCR System using QuantStudio Design and Analysis Software

(v1.4.3 or later).

For general instructions on instrument calibration, refer to the QuantStudio 5 Real-Time PCR

Instrument User Guide.

Important points before starting

l Set up calibration plate in an area separate from that used for DNA isolation and PCR

product analysis (post-PCR).

l Use QuantStudio 5 Real-Time PCR System-related consumables (optical 96-well reaction

plates and optical adhesive films).

l Use disposable tips containing hydrophobic filters to minimize cross-contamination.

l Repeat-dispenser pipettes can be used to dispense 20 µL into all 96 wells of a plate

assigned for one dye.

l For repeat dispensers, use disposable, sterile, separately wrapped repeat-dispenser tips.

l Always wear a suitable lab coat, disposable gloves, and protective goggles. Avoid

touching plate wells, optical adhesive films, and bottoms of the plates.

l We strongly recommend performing the Region- of- Interest (ROI) calibration and

background calibration before you perform the custom dye calibration with the Investigator

Quantiplex Pro Calibration Kit. Further details on how to perform ROI calibration and
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background calibration can be found in the QuantStudio 5 Real-Time PCR Instrument User

Guide.

Procedure A: Calibration plate setup

1. Thaw kit components if required. Mix all kit components before use.

2. Vortex each calibration standard for at least 5 s before removing an aliquot.

3. Dilute each Investigator Quantiplex Pro Calibration Kit standard in a separate tube (e.g.,

a 5 mL reaction tube), as described in Table 7.

Component Volume (μL)

Calibration Standard FAM 23 – – – –

Calibration Standard JOE – 23 – – –

Calibration Standard ATTO 550 – – 23 – –

Calibration Standard ROX – – – 23 –

Calibration Standard ATTO 647N – – – – 23

Quantiplex Pro Calibration Buffer 2277 2277 2277 2277 2277

Total volume 2300 2300 2300 2300 2300

Table 7. Dilution scheme for Investigator Quantiplex Pro Calibration Kit standards

4. Mix each calibration standard by vortexing for at least 5 s.

5. Assign and label one separate optical 96-well reaction plate for each Investigator

Quantiplex Pro Calibration Kit standard (5 in total).

6. Dispense 20 µL of diluted Investigator Quantiplex Pro Calibration Kit standard FAM into

the assigned dye-specific optical 96-well reaction plate.

7. Close the plate with an optical adhesive film.
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8. Repeat these steps for each of the other remaining Investigator Quantiplex Pro Calibration

Kit standards (JOE, ATTO 550, ROX, and ATTO 647N).

9. Centrifuge plates briefly. Always protect plates from light.

10. After calibration, store the calibration plates at −30°C to −15°C in a constant-temperature

freezer, protected from light. Calibration plates can be stored and reused for up to

3 months.

Procedure B: Calibration protocol for QuantStudio 5 Real-Time PCR
System

1. Start cycler and enter Settings menu on the Home screen. Select Maintenance and Service.

2. Select Calibrations, then Custom, and Custom Dye.

3. Select Add Custom Dye.

4. Enter QPP_FAM as a new dye name, confirm that Reporter is selected, and select Save.

5. Load the QPP_FAM plate prepared in Procedure A into the instrument.

6. Enter “60°C” for the calibration temperature.

7. Select Start.
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8. When the calibration is complete, the screen will display “Calibration Complete”. Select

View Results to review details. The QPP_FAM calibration spectra should show the highest

signals in filter “x1-m1”. For other QPP dyes see Table 8.

Custom dye Highest signal in filter

QPP_FAM x1-m1

QPP_JOE x2-m2

QPP_ATTO550 x3-m3

QPP_ROX x4-m4

QPP_ATTO647N x5-m5

Table 8. Calibrated dye filter signal

9. Repeat steps 1 to 8 to calibrate for the following dyes:

l QPP_JOE

l QPP_ROX

l QPP_ATTO550

l QPP_ATTO647N
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Procedure C: Adding the Quantiplex Pro dyes to QuantStudio Design
and Analysis Software (v1.4.3 or higher)

1. Open the QuantStudio Design and Analysis Software and select Tools > Dye Library.

2. Select New and add all QPP dyes:

l QPP_FAM

l QPP_JOE

l QPP_ROX

l QPP_ATTO550

l QPP_ATTO647N

Important: Dye names entered in the Dye Library must match exactly the dye names

entered on the QuantStudio 5 during custom dye calibration.
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3. Confirm that Reporter is selected for each dye and then select Save.
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Protocol: Quantification of DNA Using the
QuantStudio 5 Real-Time PCR System

This protocol is optimized for use of the Investigator Quantiplex Pro FLX Kit on the QuantStudio

5 Real-Time PCR System using QuantStudio Design and Analysis Software (v1.4.3 or later).

For general instructions on instrument setup and other software versions, refer to the

QuantStudio 5 Real-Time PCR Instrument User Guide.

Important points before starting

l When using the QuantStudio 5 Real-Time PCR System with Investigator Quantiplex Pro FLX,

custom dye calibration for FAM, JOE, ATTO 550, ROX, and ATTO 647N is needed. To

achieve optimal performance, calibrate with the Investigator Quantiplex Pro Calibration

Kit.

l Quantiplex Pro FLX Plates are compatible with the 0.2 mL block only. Do not use the 96-

well 0.1 mL Block.

l Use the cycling conditions specified in the protocol. The cycling is optimized for this assay.

l Optimal analysis settings are a prerequisite for accurate quantification data. Readjust the

analysis settings (e.g., baseline settings and threshold values) for analysis of every reporter

dye channel in every run.

Procedure A: Create an experiment

1. Open the QuantStudio Design and Analysis Software (v1.4.3 or higher).

2. Several options to set up a run are described:
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l If you are using a template file and doing a manual plate setup, proceed to step 18 to

define DNA sample names and assign to the plate layout. Then proceed to step 23 to

start the run.

l If you are using a template file and also use a .txt setup file for plate setup, proceed to

"Procedure B: Run setup using a template file and a plate setup file" on page 44.

l If you are not using a template file, proceed with step 8 on page 36.

The template file loads all of the settings needed to start an Investigator Quantiplex Pro FLX

run, including the standard curve settings, the cycling profile, and the targets needed for

fluorescence acquisition. Download the template files from the Resources tab of the

product page.

3. If you are not using a template file, select Create New Experiment.
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4. In the Properties tab, confirm the following settings in Experiment Properties:

l Instrument type: QuantStudio™ 5 System

l Block type: 96-Well 0.2 mL Block

l Experiment type: Standard Curve

l Chemistry: TaqMan® Reagents

l Run mode: Standard

Select Next.

Note: Quantiplex Pro FLX Plates are compatible with the 0.2 mL block only. Do not use the

96-well 0.1 mL block.

5. In the Method tab, adjust thermal profile by changing the holding times to those in

Table 9. Change Volume to 20 µL.
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Data acquisition should be performed during the combined annealing/extension step.

Clicking the camera symbol enables data acquisition for the step.

Select Next.
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Step Temperature (°C) Time No. of cycles Remarks

Initial PCR activation
step

98 3 min – PCR requires an initial incubation
at 98°C to activate the DNA poly-
merase

Denaturation

Combined
annealing/extension

98

65

5 s

35 s 40
–

Perform fluorescence data
collection

Note: Always use a compression pad if using the entire plate. If using 8-tube strips, please follow the PCR cycler man-
ufacturer’s recommendation for the use of strips and their position within the cycler block.

Table 9. Cycling protocol using QuantStudio 5 Real-Time PCR System

6. In the Plate tab, select Quick Setup. And then, in Plate Attributes > Passive Reference,

select QPP_ROX.
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7. Still in the Plate tab, select Advanced Setup. Click Add 3 times, and then add the targets

listed in Table 10 below.

Name Reporter Quencher

Human QPP_FAM None

Male QPP_ATTO647N None

Degradation QPP_ATTO550 None

IC QPP_JOE None

Table 10. Assign targets and samples
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8. Select the wells in use and assign all 4 targets by marking the boxes on their left.

Important: Do not highlight the wells that are not in use (i.e., those without reaction mix).

Including unused wells will significantly impact the scale of the x and y axes when viewing

the data.
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9. While in Advanced Setup, open the Samples section and select Add to enter the sample

names for the standards (e.g., Standard -1, Standard -2, etc.; or Std1, Std2, etc.) and

NTCs.

Note: Precise naming of standards is required for proper subsequent analysis with the

QIAGEN Quantification Assay Data Handling Tool.

Important: If replicates are needed, they should be assigned before you proceed to the

next step. Define replicates by using the same sample name for 2 or more wells or by

using the Biological Replicate Groups panel.*

*Instructions for using the Biological Replicate Groups panel are not covered by this handbook.
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10. Select the wells for the no-template controls (NTC) and flag them as negative control in

Task by selecting the gray N button.

Note: Leave the IC (QPP_JOE) task for NTC reactions set to U (“unknown”). In Samples,

select the sample name NTC.
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11. Select the wells for the standard curve and flag them in the Task column as standard by

selecting the orange S button.

Note: Leave the IC (QPP_JOE) task for standard reactions set to U (“unknown”).
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12. Enter the concentration and select a sample name for each standard. Enter the quantity of

DNA in the wells according to "Protocol: Setting Up Investigator Quantiplex Pro FLX

Plates" on page 18.
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13. In the Samples section, select Add to enter the names of the DNA samples.

Assign DNA samples to the plate layout by clicking on the wells and checking the

appropriate box on the left Samples panel.
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14. At the top toolbar, select Analysis > Analysis Settings.

15. In the CT Settings tab, under Default CT Settings, select the first Target. At the leftmost side

of the window, uncheck the boxes beside Default Settings and Automatic Threshold. Do

the same for the rest of the targets.
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16. Enter the following settings for each target (Table 11), and then select Apply:

Target Threshold Baseline

Degradation 0.125 Auto

Human 0.2 Auto

IC 0.05 Auto

Male 0.5 Auto

Table 11. CT settings

Important: Verify that option for Automatic Threshold is deselected for all targets. Setting

the appropriate threshold value may require further internal validation in your facility.

17. Optional: Before running the reaction plate, you can save the setup as an EDT template

file:



44 Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025

a. Select File > Save as.

b. Enter a name for the template document.

c. Select Save again.

If you do not want to save the setup as a template, proceed to the next step.

18. Load the plate into the instrument. Ensure that position A1 on the plate is on the top-left

side of the tray.

19. Select the Run tab, and then select Start Run.

Procedure B: Run setup using a template file and a plate setup file

1. Open the QuantStudio Design and Analysis Software (v1.4.3 or higher). Select Open.

2. Select the EDT template file.
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3. Click File > Import Plate Setup, select the plate setup .txt file, and then select Apply.

4. After successfully importing the plate setup, load the plate into the instrument. Ensure that

position A1 of the plate is on the top-left side of the tray.

5. Select the Run tab, and then select Start Run.

Procedure C: Data analysis

Optimal analysis settings are a prerequisite for accurate quantification data. Check and

readjust the analysis settings (i.e., threshold values) if needed for analysis of every reporter

dye channel in every run.

1. Open the run file using the QuantStudio Design and Analysis Software (v1.4.3 or later).

2. Before a standard curve can be created, standards must first be defined.
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Note: If standards had been defined before the run was started, proceed to step 4, below.

3. Go to Plate and select Advanced Setup. Define the wells that contain DNA standards as

explained in steps 10 and 11 of “Procedure A: Create an experiment” (starting on

page 30).

4. Select Analysis > Analysis Settings from the top toolbar and confirm that settings are set as

described in Table 8.

5. Select the Results tab, select the wells to be analyzed, and then select Analyze.

6. To view the standard curve, select Amplification Plot > Standard Curve from the drop

down menu.
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7. Review standard curves for each target by selecting All Target.

View the CT values for the quantification standard reactions, and the calculated regression

line, slope, y-intercept, and R2 values.

8. To export and save the results report, go to Export in the top bar. Ensure that the Results

box is checked under Content. Select Customize.
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9. Ensure All Fields are selected for export. Select Close.
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10. In Export, select Browse, choose where you want to save your file, then select Open.

11. Select Export. Save the file in *.xls format.

12. To interpret results, see “Interpreting Data Using the QIAGEN Quantification Assay Data

Handling Tool” on page 93.
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Protocol: Cycler Calibration Using the
Investigator Quantiplex Pro Calibration Kit and
Applied Biosystems 7500 Real-Time PCR System
for Human Identification

This protocol is optimized for use of the Investigator Quantiplex Pro Calibration Kit on the

Applied Biosystems 7500 Real-Time PCR System for Human Identification using HID Real-Time

PCR Analysis Software v1.1 or 1.2.

For general instructions on instrument calibration, refer to the Applied Biosystems 7500 Real-

Time PCR System for Human Identification User Manual.

Important points before starting

l Set up calibration plate in an area separate from that used for DNA isolation and PCR

product analysis (post-PCR).

l Use Applied Biosystems 7500 Real-Time PCR System-related consumables (optical 96-well

reaction plates and optical adhesive films).

l Use disposable tips containing hydrophobic filters to minimize cross-contamination.

l Repeat dispenser-pipettes can be used to dispense 20 µL into all 96 wells of a plate

assigned for one dye.

l For repeat dispensers use disposable, sterile, separately wrapped repeat dispenser tips.

l Always wear a suitable lab coat, disposable gloves, and protective goggles. Take care to

minimize touching plate wells, optical adhesive films, and bottoms of the plates.
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l We strongly recommend performing the ROI calibration, background calibration, and

optical calibration before you perform the custom dye calibration with the Investigator

Quantiplex Pro Calibration Kit. Further details on how to perform ROI calibration,

background calibration, and optical calibration can be found in the Applied Biosystems

7500 Real-Time PCR Systems Installation and Maintenance Guide.

Procedure A: Calibration plate setup

1. Thaw kit components if required. Mix all kit components before use.

2. Vortex each calibration standard for at least 5 s before removing an aliquot.

3. Dilute each Investigator Quantiplex Pro Calibration Kit standard in a separate tube (e.g.,

a 5 mL reaction tube), as described in Table 12.

Component Volume (µL)

Calibration Standard FAM 23 – – – –

Calibration Standard JOE – 23 – – –

Calibration Standard ATTO 550 – – 23 – –

Calibration Standard ROX – – – 23 –

Calibration Standard ATTO 647N – – – – 23

Quantiplex Pro Calibration Buffer 2277 2277 2277 2277 2277

Total volume 2300 2300 2300 2300 2300

Table 12. Dilution scheme for Investigator Quantiplex Pro Calibration Kit standards

4. Mix each calibration standard by vortexing for at least 5 s.

5. Assign and label one separate optical 96-well reaction plate for each Investigator

Quantiplex Pro Calibration Kit standard (5 in total).
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6. Dispense 20 µL of diluted Investigator Quantiplex Pro Calibration Kit standard FAM into

the assigned dye-specific optical 96-well reaction plate.

7. Close the plate with an optical adhesive film.

8. Repeat these steps for each of the other remaining Investigator Quantiplex Pro Calibration

Kit standards (JOE, ATTO 550, ROX, and ATTO 647N).

9. Centrifuge plates briefly. Always protect plates from light.

10. After calibration, store the calibration plates at −30°C to −15°C in a constant-temperature

freezer, protected from light. Calibration plates can be stored and reused for up to

3 months.
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Procedure B: Calibration Protocol for Applied Biosystems 7500 Real-
Time PCR Systems for Human Identification

1. Open the HID Real-Time PCR Analysis Software v1.1 or 1.2 and select the Instrument

Maintenance Manager from the instrument menu.
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2. Select the Dye section on the left panel.
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3. Select Custom Dye Calibration, then Start Calibration.
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4. Select New Dye in the Dye Calibration window.
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5. In the Dye Library window select New.
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6. Set names for the new custom dyes. To differentiate the new dyes from standard dyes, we

recommend using the prefix QPP (for Quantiplex Pro). Enter "QPP_FAM" as a new dye

name, select Reporter, and click OK.

7. Repeat step 6 to set new dye names for:

l QPP_JOE

l QPP_ATTO550

l QPP_ATTO647N
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8. Select QPP_FAM in the Custom Dye Calibration Setup window. Load the QPP_FAM plate

prepared in Procedure A into the instrument. Confirm by checking the tick box for “The

custom dye plate is loaded into the instrument”.
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9. Select Next, then Start Run.
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10. After the calibration run has finished, select Next.
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11. The spectra and the status (e.g., "Passed") will be displayed. Select Finish.

12. Repeat steps 8 to 11 to calibrate for the following dyes:

l QPP_JOE

l QPP_ATTO550

l QPP_ATTO647N
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13. To calibrate ROX, open the Dye section and select System Dye Calibration. Select Start

Calibration.

14. In the Overview window select Next.
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15. In the Materials Required window select only ROX, then Next.

16. In the Preparing the Plate window, select Next.

17. The Loading the Plate window will open. Select Next and load the plate for Calibration

Standard ROX into the instrument.

18. Select Start Run.
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19. After the calibration run has finished, select Next in the lower right corner. The spectrum

and status of ROX (e.g., "Passed") will be displayed.

20. Select Next, then Finish Calibrating ROX.

21. Confirm that the calibrated dyes provide the highest signals in the filter as shown in

Table 13.

Custom dye Highest signal in filter

QPP_FAM 1

QPP_JOE 2

QPP_ATTO550 3

ROX 4

QPP_ATTO647N 5

Table 13. Calibrated dye filter signal
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Protocol: Cycler Calibration Using the
Investigator Quantiplex Pro Calibration Kit and
Applied Biosystems 7500 Real-Time PCR System
with 7500 Software v2.0.6 or Higher

This protocol is optimized for use of the Investigator Quantiplex Pro Calibration Kit on the

Applied Biosystems 7500 Real-Time PCR System with 7500 Software v2.0.6 or later.

For general instructions on instrument calibration, refer to the Applied Biosystems 7500 Real-

Time PCR System for Human Identification User Manual.

Important points before starting

l Set up calibration plate in an area separate from that used for DNA isolation and PCR

product analysis (post-PCR).

l Use Applied Biosystems 7500 Real-Time PCR System-related consumables (optical 96-well

reaction plates and optical adhesive films).

l Use disposable tips containing hydrophobic filters to minimize cross-contamination.

l Repeat dispenser-pipettes can be used to dispense 20 µL into all 96 wells of a plate

assigned for one dye.

l For repeat dispensers use disposable, sterile, separately wrapped repeat dispenser tips.

l Always wear a suitable lab coat, disposable gloves, and protective goggles. Take care to

minimize touching plate wells, optical adhesive films, and bottoms of the plates.

l We strongly recommend performing the ROI calibration, background calibration, and

optical calibration before you perform the custom dye calibration with the Investigator
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Quantiplex Pro Calibration Kit. Further details on how to perform ROI calibration,

background calibration, and optical calibration can be found in the Applied Biosystems

7500 Real-Time PCR Systems Installation and Maintenance Guide.

Procedure A: Calibration plate setup

1. Thaw kit components if required. Mix all kit components before use.

2. Vortex each calibration standard for at least 5 s before removing an aliquot.

3. Dilute each Investigator Quantiplex Pro Calibration Kit standard in a separate tube (e.g.,

a 5 mL reaction tube), as described in Table 14.

Component Volume (µL)

Calibration Standard FAM 23 – – – –

Calibration Standard JOE – 23 – – –

Calibration Standard ATTO 550 – – 23 – –

Calibration Standard ROX – – – 23 –

Calibration Standard ATTO 647N – – – – 23

Quantiplex Pro Calibration Buffer 2277 2277 2277 2277 2277

Total volume 2300 2300 2300 2300 2300

Table 14. Dilution scheme for Investigator Quantiplex Pro Calibration Kit standards

4. Mix each calibration standard by vortexing for at least 5 s.

5. Assign and label one separate optical 96-well reaction plate for each Investigator

Quantiplex Pro Calibration Kit standard (5 in total).

6. Dispense 20 µL of diluted Investigator Quantiplex Pro Calibration Kit standard FAM into

the assigned dye-specific optical 96-well reaction plate.

7. Close the plate with an optical adhesive film.
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8. Repeat these steps for each of the other remaining Investigator Quantiplex Pro Calibration

Kit standards (JOE, ATTO 550, ROX, and ATTO 647N).

9. Centrifuge plates briefly. Always protect plates from light.

10. After calibration, store the calibration plates at –30°C to –15°C in a constant-temperature

freezer, protected from light. Calibration plates can be stored and reused for up to

3 months.
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Procedure B: Calibration Protocol for Applied Biosystems 7500 Real-
Time PCR Systems with 7500 Software v2.0.6 or higher

1. Open the 7500 Software v2.0.6 or later and select the Instrument Maintenance Manager

from the Instrument menu.
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2. Select the Dye section in the left panel.



Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 71

3. Select Custom Dye Calibration, then Start Calibration.
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4. Select New Dye in the Dye Calibration window.
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5. In the Dye Library window select New.



74 Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025

6. Set names for the new custom dyes. To differentiate the new dyes from standard dyes, we

recommend using the prefix QPP (for Quantiplex Pro). Enter "QPP_FAM" as a new dye

name, select Reporter, then OK.

7. Repeat step 6 to set new dye names for:

l QPP_JOE

l QPP_ATTO550

l QPP_ROX

l QPP_ATTO647N



Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 75

8. Select QPP_FAM in the Custom Dye Calibration Setup window. Load the QPP_FAM plate

prepared in Procedure A into the instrument. Confirm by checking the box for “The custom

dye plate is loaded into the instrument”.
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9. Select Next, then Start Run.
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10. After the calibration run has finished, select Next.
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11. The spectra and the status (e.g., “Passed”) will be displayed. Select Finish.

12. Repeat steps 8 to 11 to calibrate for the following dyes:

l QPP_JOE

l QPP_ATTO550

l QPP_ROX

l QPP_ATTO647N
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13. Confirm that the calibrated dyes provide the highest signals in the filter as shown in

Table 15.

Custom dye Highest signal in filter

QPP_FAM 1

QPP_JOE 2

QPP_ATTO550 3

ROX 4

QPP_ATTO647N 5

Table 15. Calibrated dye filter signal
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Protocol: Quantification of DNA Using the
Applied Biosystems 7500 Real-Time PCR System
for Human Identification or Applied Biosystems
7500 Real-Time PCR System

This protocol is optimized for use of the Investigator Quantiplex Pro FLX Kit on the Applied

Biosystems 7500 Real-Time PCR System for Human Identification using HID Real-Time PCR

Analysis Software v1.1 or v1.2, or the Applied Biosystems 7500 Real-Time PCR System using

7500 Software v2.0.6 or v2.3.

For general instructions on instrument setup and other software versions, refer to the Applied

Biosystems 7500 Real-Time PCR System for Human Identification User Manual or Applied

Biosystems 7500 Real-Time PCR System User Manual.

Important points before starting

l When using the Applied Biosystems 7500 Real-Time PCR System for Human Identification

or the Applied Biosystems 7500 Real-Time PCR System with Investigator Quantiplex Pro FLX

Kit, custom dye calibration for FAM, JOE, ATTO 550, ROX, and ATTO 647N is strongly

recommended. To achieve optimal performance, calibrate with the Investigator Quantiplex

Pro Calibration Kit (cat. no. 387416).

l Use the cycling conditions specified in the protocol. The cycling is optimized for this assay.

l Optimal analysis settings are a prerequisite for accurate quantification data. Readjust the

analysis settings (i.e., threshold values) for analysis of every reporter dye channel in every

run.
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Procedure A: Creating an experiment

Open the HID Real-Time PCR Analysis Software v1.1 or v1.2 in the Custom Assays mode. If

using the Applied Biosystems 7500 Real-Time PCR System, launch the 7500 Software v2.0.6

or v2.3.

1. If you are using a template file, select New Experiment > From Template and proceed to

step 6 to assign the Targets to the Plate Layout. Then proceed to step 12 on page 88 to

save and start the run.

If you are not using a template file, proceed to step 2.

The template file loads all of the settings needed to start an Investigator Quantiplex Pro FLX

run, including the standard curve settings, the cycling profile, and the targets needed for

fluorescence acquisition. Download the template files from the Resources tab of the

product page.
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2. If you are not using a template file, select Advanced Setup by clicking the arrow below

Design Wizard.
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3. Once the new window opens, enter a new Experiment Name in the appropriate field.

Select the following settings:

l Instrument: 7500 (96 Wells)

l Experiment Type: Quantitation – Standard curve

l Reagents: TaqMan Reagents

l Ramp Speed: Standard

Deselect the Include Melt Curve option.
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4. Select Plate Setup and define 4 Targets by clicking twice on Add New Target. Select the

following settings.

l Human, Reporter: QPP_FAM, Quencher: None

l IC, Reporter: QPP_JOE, Quencher: None

l Degradation, Reporter: QPP_ATTO550, Quencher: None

l Male, Reporter: QPP_ATTO647N, Quencher: None

5. Define the Sample names and also the names for the Standards (e.g., Standard 1 or Std1,

Standard 2 or Std2, etc.) using the Define Samples tool on the right panel. Precise naming

of Standards is required for proper subsequent analysis with the QIAGEN Quantification

Assay Data Handling Tool.
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Important: If replicates are needed they should be assigned before you proceed to the

next step. Define replicates by using the same sample name or in the Define Biological

Replicate Groups panel.

6. Switch to the tab Assign Targets and Samples. In the Plate Layout, select the wells in use

and assign all 4 Targets by checking the boxes.

If using Applied Biosystems 7500 Real-Time PCR System with Software v2.0.6 or later,

make sure to change passive reference dye to QPP_ROX.

Important: Do not highlight the wells that are not in use (i.e., those without reaction mix).

Including unused wells will significantly impact the scale of the X and Y axes when

viewing the data.

Figure 5. Settings for HID Real-Time PCR Analysis Software v1.1 or v1.2.
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Figure 6. Settings for Applied Biosystems 7500 Real-Time PCR System with Software v2.0.6 or higher.

7. Select the wells for the no- template controls (NTC) and flag them as Negative Control

using the gray N button.

Note: Leave the IC (QPP_JOE) Task for NTC reactions set to Unknown. Enter the sample

name.

8. Select the wells for the standard curve and flag them as Standard using the orange

S button. Select Quantity for the appropriate detector and enter the quantity of DNA in the

well according to Table 3 on page 19.

Important: Although units are not entered for Quantity, a common unit must be used for all

standard quantities (e.g., ng/µL). The units used for standard quantities define the

quantification units for analysis of results.

Note: Leave the IC (QPP_JOE) Task for standard reactions set to Unknown.
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9. Assign the samples to the plate layout by clicking on the wells and checking the

appropriate box on the left panel.

10. Select Run Method. Program the cycler according to Table 16.

Step
Temperature
(°C) Time No. of cycles Remarks

Initial PCR activation
step

98 3 min – PCR requires an initial incub-
ation at 98°C to activate the
DNA polymerase

Denaturation 98 5 s

40

–

Combined
annealing/extension

65 35 s Perform fluorescence data
collection

Note: Always use a compression pad if using the entire plate. If using 8-tube strips, please follow the PCR cycler
manufacturer’s recommendation for the use of strips and their position within the cycler block.

Table 16. Cycling protocol using an Applied Biosystems 7500 Real Time PCR System for Human Identification or
Applied Biosystems 7500 Real Time PCR System
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11. On the thermal profile, change the Reaction Volume Per Well to 20 µL. Data acquisition

should be performed during the combined annealing/extension step.

12. Before running the reaction plate, save the plate document as an EDS Document (*.eds)

file. Select File, and then Save. Enter a name for the plate document, then select Save

again.

13. Load the plate into the instrument. Ensure that position A1 on the plate is on the top-left

side of the tray.

14. Start the reaction by selecting Start.

Procedure B: Data analysis

Optimal analysis settings are a prerequisite for accurate quantification data. Readjust the

analysis settings (i.e., threshold values) for analysis of every reporter dye channel in every run.
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1. Open the run file using the HID Real-Time PCR Analysis Software v1.1 or v1.2. First you

must open the software in the Custom Assays Mode. Select Open and then Browse to

locate the saved file.

If using Applied Biosystems 7500 Real-Time PCR System open the run file by using 7500

Software v2.0.6 or higher. Select Open and then Browse to locate the saved file.

2. Standards must first be defined before a standard curve can be created. If the standards

were defined before the run was started, proceed to step 4, below.

3. Select Setup, then Plate Setup. Define the wells that contain DNA standards as explained

in step 8 on page 86.

Important: Although units are not entered for Quantity, a common unit must be used for all

standard quantities (e.g., ng/µL). The units used for standard quantities define the

quantification units for the analysis of results.

Note: Leave the IC (QPP_JOE) Task for standard reactions set to Unknown. Enter the

sample name (e.g., Standard 50 ng/µL).

4. In the Amplification Plot tab (found in the Analysis tab), select the appropriate samples in

the table below the amplification plot. Choose Human, set threshold to 0.2, and then

select Analyze. Repeat this for Male, Degradation, and IC with the following thresholds

listed:

Note: Alternatively, select Analysis Settings in the upper right corner to set all analysis

settings.

l Human: 0.2

l Male: 0.5

l Degradation: 0.2
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l IC: 0.05

l Auto Baseline for all targets

Note: Verify that option for Auto Threshold is deselected for all Targets. Setting the

appropriate threshold value may require further internal validation at your facility.
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5. To view the standard curve, select the Standard Curve tab (found in the Results tab). View

the CT values for the quantification standard reactions and the calculated regression line,

slope, y-intercept, and R2 values.

6. View the concentrations of the unknown samples.

The Well Table displays data for the selected wells and summarizes the quantity of DNA

present in the unknown samples. The Human Target shows the quantity of DNA present

with the same units as used for the standards (i.e., if ng/µL was used for the definition of

the standards, then the quantities for the unknowns will be reported in ng/µL). The Male

and Degradation Targets show the quantity of male and human DNA present, with the

same units as used for the standards. The IC Target shows the CT value for the internal

control.

Important: If replicates are needed they have to be assigned before you proceed to the

next step and export your data for further analysis with the QIAGEN Quantification Assay
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Data Handling Tool. Mean quantification values should be displayed if replicates have

been assigned.

7. To export and save the results report, select File, followed by Export, and then Results. The

analysis settings must be saved first, then the results may be saved in the format Results

Export Files *.csv.

8. To interpret the results, see “Interpreting Data Using the QIAGEN Quantification Assay

Data Handling Tool”, next chapter.
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Interpreting Data Using the QIAGEN
Quantification Assay Data Handling Tool

The QIAGEN Quantification Assay Data Handling Tool is designed for accurate

quantification, data analysis, and interpretation. The Opening Page worksheet contains

information on version number and software requirements/compatibility. On the

Configuration worksheet, the root directories for data processing, result import options, and

default values for analysis criteria and thresholds can be set. Each worksheet contains an

instruction button, which, when pressed, provides detailed instructions on using the functions

of the specific worksheet.
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Procedure

1. Open QIAGEN Quantification Assay Data Handling Tool.

2. If the cycler has been calibrated with the Investigator Quantiplex Pro Calibration Kit and if

the Data Handling Tool is being used for the first time on your computer, a one- time

update has to be conducted. For proper functioning of the Data Handling Tool please

ensure that the QPP dyes have been named exactly on your cycler as described in the

calibration section of this handbook. The one-time update will set proper dye naming in

the Data Handling Tool. Save the Data Handling Tool afterwards on your computer. If you

are using the Data Handling Tool the first time on your computer proceed to step 3. If the

one-time update has already been done and the changes have been saved proceed to

step 4.

3. Select the blue One Time update button.

4. Select the Configuration worksheet tab.

5. Set the root/home directory to save Quant batch files.



Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 95

6. Set the root/home directory to import Quant result files.

7. Target names should be assigned for the Applied Biosystems 7500 Real-Time PCR System.

Select Enter Defaults, then ABI 7500/Quantstudio. Default names for the targets are

“Human” (Human Target), “Male” (Male Target), “Degradation “(Degradation Target),

and “IC” (Internal Positive Control). Defaults can be restored by selecting Enter Defaults.

Note: The Male Degradation Marker is only available in the Investigator Quantiplex Pro

RGQ Kit.

8. Threshold setting for the Quality Assessment can be changed/adjusted as needed. Below

are the default threshold settings.

l Mixture index (Human/Male): 2

l Degradation Index (Human/Degradation): 10
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l Inhibition Index (IC Shift): 1

Note: Setting the appropriate threshold values may require further internal validation at

your facility. 9948 will be filtered from the import, provided it is included in the section

“Quantification QC Control Specification”. Removing it allows it to be kept in the final

data set.

Defaults can be restored by selecting Enter Defaults.

9. To import quantification results, select the Quant Result Import worksheet tab.



Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 97

10. Select Import QuantData.

11. Confirm that the exported data are in the appropriate format.



98 Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025

Your quantification data are now imported and the data analyzed. The Mixture Index,

Degradation Index, and Inhibition Index are calculated and tagged as “Below Threshold”,

“Possible Mixture”, “Possible Degradation”, or “Possible Inhibition”.

12. Display options can be adjusted by selecting Display Settings:

l Show Raw Data

l Show Quantity Mean Values

l Show CT Values

Note: The Degradation Index is set to 10 as a default. Full STR profiles can be obtained

with DNA fragmented to an average fragment size of approximately 300 bp. The default

Degradation Index of 10 should allow differentiation between DNA fragments larger or

smaller than 300 bp.
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Note: The Inhibition Index is set to 1 as a default. The IC acts as a quality sensor and

reports the presence of inhibitors with a CT shift while quantification remains reliable. The

default value can be changed and adjusted for relevant degrees of inhibition. Therefore,

laboratory validation should be performed to determine criteria for detecting inhibition.

Apply concentration correction factor (only necessary if sample volume was not 2 µL) by

selecting Quantiplex Pro FLX Adjustment.

By checking or unchecking the box, you can choose between:

a. the same correction factor is applied to all samples

or;
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b. a separate correction factor is used for each sample individually (if the input volume of

the samples differs).

After entering the sample volume, select Apply Adjustments.

Back in the Quant Result Import sheet, the samples are corrected with the selected

correction factor.
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General Interpretation of Results

General considerations for data analysis

Real- time PCR data are produced as sigmoidal- shaped amplification plots (when using a

linear scale), in which fluorescence is plotted against the number of cycles.

The threshold cycle (CT value) serves as a tool for calculation of the starting template amount in

each sample. This is the cycle in which there is the first detectable significant increase in

fluorescence.

The optimal threshold setting depends on the reaction chemistries used for PCR. Therefore, an

optimal threshold setting that has been established for another kit may not be suitable for the

Investigator Quantiplex Pro FLX Kit and may need to be adjusted.

For DNA quantification using the Investigator Quantiplex Pro FLX Kit, the analysis settings must

be adjusted for all reporter dyes.

Standard curve

The standard curve is the best fit for a linear regression to the standard dilution series data.

The equation is in the form

where represents the log concentration and is the threshold cycle CT.
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The slope

The slope describes the PCR efficiency. A slope of –3.3 indicates 100% PCR efficiency

(i.e., the number of copies of amplification product is doubled at each cycle). Typically, the

slope ranges between −3.0 and −3.6. If the values fall outside of this range, see the

Troubleshooting Guide (page 110) for more information.

The y-intercept

The y-intercept indicates the expected CT value for a sample with a quantity value of 1 (for

example, 1 ng/µL).

The R2 value

The R2 value is a measure of the fit of the data points to the regressed line. In general, the

standard curve has an R2 value ≥0.990. Low R2 values (R2 ≤ 0.98) may occur for many

different reasons. In case of low R2 values, see the Troubleshooting Guide on page 105 for

more information.

Internal control

The internal control (IC) is intended to report chemistry or instrument failure, errors in assay

setup, and the presence of inhibition in the sample. The IC system is designed to be more

sensitive to inhibition than the specific target for human DNA. Therefore, the quantification will

be valid even if some inhibition is present in the sample. In this case, the operator will get

information both about the concentration of DNA in the sample and about the presence of

inhibitors. Comparison of the CT value of the IC system for DNA standards with the CT values

of the IC system for unknown samples can provide an indication of potential inhibition. At

higher concentrations of inhibitor, the quantification data may be affected, and this must be

considered for downstream applications. In general, the internal control can be interpreted in

the following manner:

Z_Investigator/Quantiplex/ProFLX/02 Protocols/17_TroubleshootingGuide.htm


Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 103

a) IC system shows normal amplification. No IC shift greater
than specified is observed. No amplification of the Human,
Degradation, and Male Targets is detectable.

No or insufficient DNA was present.

b) IC shift is greater than specified. Degradation Index is below
threshold.

Sample contains inhibitors. DNA is not degraded.

c) IC shift is greater than specified. Degradation Index is above
threshold.

Sample contains inhibitors. DNA is possibly
degraded.

Note: Extremely high concentrations of inhibitors
can inhibit amplification of the Degradation target
and trigger the Degradation Index.

Important: Internal laboratory validation with relevant inhibitors should be performed to

determine criteria for detecting inhibition.

Quantification of unknowns

The Investigator Quantiplex Pro FLX Kit can quantify a broad range of DNA amounts in a

sample, from 200 ng/µL to approximately 0.5 pg/µL of human genomic DNA. In the low

DNA concentration range, statistical effects, known as stochastic variations, can significantly

affect the assay result. When using samples with low concentrations of DNA, increased

template input volumes, and/or running replicates may give more reliable results.

Quantification of female/male mixtures

The Investigator Quantiplex Pro FLX Kit provides high sensitivity to detect low amounts of male

DNA even in a very high background of female DNA. The Mixture Index provides information

on whether a sample is a female/male mixture. In general, the Mixture Index can be

interpreted in the following manner:

a) The sample has a Mixture Threshold below the index
specified.

The sample contains only male DNA or only low levels of
female DNA.

b) The sample has a Mixture Threshold above the index
specified.

The sample contains a possible male DNA/female DNA
mixture.
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Degradation status assessment

Environmental degradation may occur with forensic casework samples and is a typical

challenge in routine genetic fingerprinting. The Investigator Quantiplex Pro FLX Kit contains a

newly developed system for detection of DNA degradation. In general, the Degradation Index

can be interpreted in following manner:

a) The sample has a Degradation Threshold below the index
specified. No IC shift is detected.

DNA is most likely not degraded. The sample
most likely contains no inhibitors.

b) The sample has a Degradation Threshold below the index
specified. IC shift is detectable above the threshold.

DNA is most likely not degraded. The sample
may contain inhibitors.

c) The sample has a Degradation Threshold above the index
specified. No IC shift is detected.

DNA is most likely degraded. The sample most
likely contains no inhibitors.

d) The sample has a Degradation Threshold above the index
specified. IC shift is detectable above the threshold.

DNA may or may not be degraded. The sample
contains inhibitors.

Note: When 2 µL of a sample with very low concentrations is loaded in a reaction, the well

probably contains less than 1 diploid human genome equivalent. In the low DNA

concentration range, statistical effects, known as stochastic variations, can affect the assay. In

case of degraded DNA with a very low DNA concentration, the Degradation target can be

affected. If the Degradation target has an undetermined value, the sample will be tagged with

“Possible Degradation”. Extremely high inhibitor concentrations can also affect the

Degradation target and lead to a “Possible Degradation” flag.
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Troubleshooting Guide

This troubleshooting guide may be helpful in solving any problems that may arise. For more

information, see also the Frequently Asked Questions page at our Technical Support Center:

www.qiagen.com/FAQ/FAQList.aspx. The scientists in QIAGEN Technical Services are

always happy to answer any questions you may have about either the information and

protocols in this handbook or sample and assay technologies (for contact information, see

back cover or visit www.qiagen.com).

Comments and suggestions

No signal or one or more signals detected late in PCR

a) Incorrect cycling
conditions

Always use the optimized cycling conditions specified in the protocols. Make sure to select ROX
or QPP_ROX as the passive dye on Applied Biosystems instruments.

b) Pipetting error,
missing or
degraded reagent

Check the storage conditions of the reagents. Repeat the assay.

c) Incorrect or no
detection step

Make sure that fluorescence detection takes place during the combined annealing/extension
step.

d) Insufficient
amount of starting
template

Increase the amount of template, if possible. Ensure that sufficient copies of the template DNA
are present in the sample.

e) Problems with
starting template

Check the storage conditions of the starting template DNA. Efficient removal of PCR inhibitors is
essential for optimal results. Purify nucleic acids from your sample using an appropriate puri-
fication method. Ensure that all reagents, buffers and solutions used for isolating and diluting
template nucleic acids are free from nucleases.

f) Wrong detection
channel/filter
chosen

Ensure that the correct detection channel is activated or the correct filter set is chosen for each
reporter dye. Ensure that the chosen combination of reporter dyes is compatible with the selec-
ted detection channels or filter sets.

g) Degraded control
DNA

Make new serial dilutions of the control DNA from the stock solution. Repeat the assay using the
new dilutions.

https://www.qiagen.com/FAQ/FAQList.aspx
https://www.qiagen.com/
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Comments and suggestions

Differences in CT values or in PCR efficiencies between runs

a) Incorrect cycling
conditions

Always start with the optimized cycling conditions specified in the protocols. Ensure that the cyc-
ling conditions include the initial step for activation of the DNA polymerase and the specified
times for denaturation and annealing/extension.

b) Analysis settings
(e.g., threshold and
baseline settings)
not optimal

Check the analysis settings (threshold and baseline settings) for each reporter dye. Repeat ana-
lysis using optimal settings for each reporter dye.

No linearity in ratio of CT value/crossing point to log of the template amount

Amount of template
in unknown sample
too high

Linearity is guaranteed within the range of the standard curve. If signals appear at very early CT
values, dilute the sample and repeat the reaction.

Increased fluorescence or CT value for no-template control

a) Contamination of
reagents

Discard all the components of the assay (e.g., master mix). Repeat the assay using new com-
ponents.

b) Minimal probe
degradation,
leading to sliding
increase in
fluorescence

Check the amplification plots, and adjust the threshold settings.

c) Crosstalk
problems

Depending on the instrument, different techniques are used to avoid spectral crosstalk when
using multiple fluorophores for multiplex assays. However, minimal crosstalk, as a result of resid-
ual spectral overlap, may be observed in the NTC wells, especially if the instrument is in need of
calibration.

Varying fluorescence intensity

a) Contamination of
real-time cycler

Reactions were contaminated with target DNA. Decontaminate the real-time workstations and
the cycler according to the manufacturer’s instructions. Use new reagents and solutions.

b) Real-time cycler
no longer
calibrated

Recalibrate the real-time cycler according to the manufacturer’s instructions.
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Comments and suggestions

c) Wavy curve at
high template
amounts for highly
concentrated targets

In the analysis settings, reduce the number of cycles used for background calculation (if the real-
time cycler allows this) or reduce the amount of template.

Slope for the standard curve differs significantly from –3.33 or R2 value is significantly less than 0.98–0.99

a) Contamination of
real-time cycler

Decontaminate the real-time cycler according to the manufacturer’s instructions.

b) Real-time cycler
and/or pipettes no
longer calibrated

Recalibrate the real-time cycler according to the manufacturer’s instructions. Calibrate pipettes
to minimize pipetting variability.

c) Wavy curve at
high template
amounts for highly
concentrated targets

In the analysis settings, reduce the number of cycles used for background calculation or reduce
the amount of template.

d) Problem with
dilution of
standards

Ensure that the DNA standard is completely thawed and mixed thoroughly before use.

Ensure that dilutions of the DNA standard are mixed thoroughly before removing each aliquot
for the serial dilution.

Change pipette tips between each dilution step.

e) Plate not sealed Carefully seal the plates to avoid evaporation.

f) Error made during
dilution of the DNA
standard

Verify all calculations, and repeat dilution of the DNA standard.

g) Incorrect
concentration
values entered in
the software

Verify the concentrations for all samples used to generate the standard curve.

h) Abnormal
fluorescence

Do not write on the plate. Use caution when handling plates. Wear gloves.

i) Statistical
variation

Some variation in the reaction is normal, particularly when the DNA target is present at a low
copy number. Perform at least duplicates for the standard curve to minimize the effect of this
variation.
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Comments and suggestions

Handling of Quantiplex Pro FLX Plates

a) Lyophilized cake
disturbed by
pipetting

Do avoid to touch the cake while pipetting sample or water. With automated setup, check if z-
height settings accommodate for cakes. Also consider z-height settings for loosened and/or
upside down cakes.

b) No lyophilized
cake, or part of it
lost

Ensure no lyophilized product sticks to the seal before removing it. Tap the plate to bring all
cakes down. Do not use wells from which product was lost.

c) Lyophilized
product at the side
of the well after
setup

Do vortex the re-sealed plate after setup. If only pipette mixing is performed, some lyophilized
product may stay at the side of the well.

d) Lyophilized cake
shrunk, hard to
redissolve

The cake may have become rehydrated. Avoid prolonged open times of the plate before setup
and setup under conditions of more than 60% humidity. Rehydrated cakes require more time to
dissolve. In general, once completely dissolved, reactions can still be used.

e) Evaporation of
chemistry during
qPCR run

Always use a compression pad for qPCR runs of full plates.

f) Lyophilized cake
shrunk, hard to
redissolve after
storage

Always store unused part of the sealed PCR plate in the aluminum bag with desiccant and use
up within 4 weeks.

g) Issues to remove
seals from strips

Use a scalpel to cut between the strips before breaking the plate.

h) Cannot start run
with 8-well strips

Follow the PCR cycler manufacturer’s recommendation for the use of strips and their position
within the cycler block.

i) qPCR strips
sticking to the
cycler’s lid

Use a compression pad also for strips to avoid qPCR strips from sticking to the lid and being lif-
ted after the run. Optionally, remove the black frame adapter from the QuantStudio5 cycler.

j) Contamination of
strips

Use forceps for single strips of perforated qPCR seals to simplify peeling and to reduce risk of
contamination.
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Appendix: Alternative Standard Curves

Serial dilution of control DNA (ng/µL) Amount of control DNA (µL) QuantiTect Nucleic Acid Dilution Buffer (µL)

50 Undiluted DNA –

5 5 45

0.5 5 45

0.05 5 45

0.005 5 45

Table 17. Alternative 5-point standard curve (10x dilution)

Serial dilution of control DNA (ng/µL) Amount of control DNA (µL) QuantiTect Nucleic Acid Dilution Buffer (µL)

50 Undiluted DNA –

7.1429 5 40

1.0204 5 40

0.0686 5 40

0.0076 5 40

0.0030 5 40

Table 18. Alternative 6-point standard curve (9x dilution)
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Serial dilution of control DNA (ng/µL) Amount of control DNA (µL) QuantiTect Nucleic Acid Dilution Buffer (µL)

50 Undiluted DNA –

10 10 40

2 10 40

0.4 10 40

0.08 10 40

0.016 10 40

0.0032 10 40

Table 19. Alternative 7-point standard curve (5x dilution)
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Ordering Information

Product Contents Cat. no.

Investigator Quantiplex Pro FLX Kit
(576)

6x single blistered 96-well optical plates with Master Mix, Control
DNA M1, and QuantiTect Nucleic Acid Dilution Buffer

387516

Investigator Quantiplex Pro
Calibration Kit

Calibration Standard FAM, JOE, ATTO 550, ROX, ATTO 647N,
and Quantiplex Pro Calibration Buffer

387416

Related products

Investigator Casework GO! Kit
Casework GO! Lysis Buffer, Proteinase K Solution, and Nuclease-
free water

386546

qPCR adhesive plate foil,
perforated (100)

Clear adhesive foils for qPCR plates, perforated for tearing into 8-
well strips

386055

qPCR adhesive plate foil (100) Clear adhesive foils for qPCR plates 209003

PCR Water (10 x 1 mL)
Water certified to be free of DNA, DNase and RNase con-
tamination

17000–10

Investigator Human Identification PCR Kits

Investigator 24plex QS Kit (100)*
Primer mix, Fast Reaction Mix 2.0, Control DNA, allelic ladder,
DNA size standard, and Nuclease-free water

382415

Investigator 26plex QS Kit (100)*
Primer mix, Fast Reaction Mix 3.0, Control DNA, allelic ladder,
and Nuclease-free water

382615

Investigator ESSplex SE QS Kit
(100)*

Primer Mix, Fast Reaction Mix 2.0, Control DNA, allelic ladder,
DNA size standard, and Nuclease-free water

381575

Investigator Argus X-12 QS Kit
(25)*

Primer mix, Fast Reaction Mix 2.0, Control DNA, allelic ladder,
DNA size standard, and Nuclease-free water

383223

Investigator Argus Y-28 QS Kit
(100)

Primer mix, Fast Reaction Mix 3.0, Control DNA, allelic ladder,
DNA size standard, and Nuclease-free water

383625

* Larger kit sizes available; please inquire.

For up- to- date licensing information and product- specific disclaimers, see the respective

QIAGEN kit handbook or user manual. QIAGEN kit handbooks and user manuals are
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available at www.qiagen.com or can be requested from QIAGEN Technical Services or your

local distributor.

http://www.qiagen.com/


Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 113

Document Revision History

Date Description

02/2024 Initial release

02/2025 Added mention of correct position of strip in the cycler block to the notes on using 8-tube strips.
Updated the protocol for quantification of DNA using the QuantStudio 5 Real-Time PCR System to men-
tion block compatibility of the kit. Updated the Troubleshooting Guide.
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Limited License Agreement for Investigator Quantiplex Pro FLX Kit

Use of this product signifies the agreement of any purchaser or user of the product to the following terms:

1. The product may be used solely in accordance with the protocols provided with the product and this Instructions for
Use and for use with components contained in the panel only. QIAGEN grants no license under any of its
intellectual property to use or incorporate the enclosed components of this panel with any components not included
within this panel except as described in the protocols provided with the product, this Instructions for Use, and
additional protocols available at www.qiagen.com. Some of these additional protocols have been provided by
QIAGEN users for QIAGEN users. These protocols have not been thoroughly tested or optimized by QIAGEN.
QIAGEN neither guarantees them nor warrants that they do not infringe the rights of third-parties.

2. Other than expressly stated licenses, QIAGEN makes no warranty that this panel and/or its use(s) do not infringe
the rights of third-parties.

3. This panel and its components are licensed for one-time use and may not be reused, refurbished, or resold.

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated.

5. The purchaser and user of the panel agree not to take or permit anyone else to take any steps that could lead to or
facilitate any acts prohibited above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any
Court, and shall recover all its investigative and Court costs, including attorney fees, in any action to enforce this
Limited License Agreement or any of its intellectual property rights relating to the panel and/or its components.

For updated license terms, see www.qiagen.com.

Trademarks: QIAGEN®, Sample to Insight®, 4NS1C®, Investigator®, Q- Bond®, QuantiNova®, Quantiplex®,
QuantiTect® (QIAGEN Group); Applied Biosystems®, FAM™, JOE™ (Life Technologies Corporation); Cy® (GE
Healthcare); TaqMan® (Roche Group). Registered names, trademarks, etc. used in this document, even when not
specifically marked as such, are not to be considered unprotected by law.

02/2025 HB-3538-002 © 2025 QIAGEN, all rights reserved.

http://www.qiagen.com/


Investigator Quantiplex Pro FLX Kit Handbook  |  02/2025 115

This page intentionally left blank



Ordering www.qiagen.com/shop  |  Technical Support support.qiagen.com  |  Website www.qiagen.com

http://www.qiagen.com/shop
http://support.qiagen.com/
http://www.qiagen.com/

	Kit Contents
	Shipping and Storage
	Intended Use
	Safety Information
	Quality Control
	Introduction
	Principle and procedure
	Quantiplex Pro FLX Reaction Mix

	Equipment and Reagents to Be Supplied by User
	Equipment
	Material
	Reagents
	Investigator Quantiplex Pro Calibration Kit (cat. no. 387416)

	Important Notes
	Selecting kits and protocols
	Contamination risks
	Controls

	Protocol: Setting Up Investigator Quantiplex Pro FLX Plates
	Important points before starting
	Procedure: Preparing the optical plate for reaction setup

	Protocol: Cycler Calibration Using the Investigator Quantiplex Pro Calibratio...
	Important points before starting
	Procedure A: Calibration plate setup
	Procedure B: Calibration protocol for QuantStudio 5 Real-Time PCR System
	Procedure C: Adding the Quantiplex Pro dyes to QuantStudio Design and Analysi...

	Protocol: Quantification of DNA Using the QuantStudio 5 Real-Time PCR System
	Important points before starting
	Procedure A: Create an experiment
	Procedure B: Run setup using a template file and a plate setup file
	Procedure C: Data analysis

	Protocol: Cycler Calibration Using the Investigator Quantiplex Pro Calibratio...
	Important points before starting
	Procedure A: Calibration plate setup
	Procedure B: Calibration Protocol for Applied Biosystems 7500 Real-Time PCR S...

	Protocol: Cycler Calibration Using the Investigator Quantiplex Pro Calibratio...
	Important points before starting
	Procedure A: Calibration plate setup
	Procedure B: Calibration Protocol for Applied Biosystems 7500 Real-Time PCR S...

	Protocol: Quantification of DNA Using the Applied Biosystems 7500 Real-Time P...
	Important points before starting
	Procedure A: Creating an experiment
	Procedure B: Data analysis

	Interpreting Data Using the QIAGEN Quantification Assay Data Handling Tool
	Procedure

	General Interpretation of Results
	General considerations for data analysis
	Standard curve
	Internal control
	Quantification of unknowns
	Quantification of female/male mixtures
	Degradation status assessment

	Troubleshooting Guide
	Appendix: Alternative Standard Curves
	Ordering Information
	Document Revision History

